Although AutoCAD has very powerful 3D modeling capabilities, most people use it for modeling geometric shapes or extruding a closed figure, which results in angular-looking models. The recent introduction of mesh modeling now allows for more free-form organic shapes. Traditionally, Autodesk products have been separated into distinct categories: AutoCAD for lines and arcs, Autodesk® Inventor® for parts and machines. Neither of these methods handles non-prismatic shapes very well. This class will explore the use of mesh modeling tools and techniques for creating organic shapes in AutoCAD for manufacture or in AutoCAD® Civil 3D® software for landscape design.

Learning Objectives
At the end of this class, you will be able to:

- Create 3D mesh objects
- Modify 3D mesh objects
- Convert from mesh to solid objects
- Use solid object modeling tools for creating molds, then export for use in other programs or computer numerical control (CNC) machines
- Use mesh modeling to create landscape features for use in Civil 3D

About the Speaker
Dave began his search for CAD enlightenment in the civil engineering world, drawing up mortgage surveys about 20 years ago. From there, he switched over to a CAD manager position and then to IT manager, then started working with an Autodesk reseller about five years ago. His computer science degree and IT background have helped him along the way with customizing and implementing unique solutions for over a dozen years.

Although his family still doesn’t know how to explain what he does, Dave has been working at Repro Products (an Autodesk reseller) to help companies with their Autodesk training and implementation needs.
Types of Modeling in AutoCAD (The Autodesk Definition)

Solid Model
A solid model is an enclosed 3D body that has properties such as mass, volume, center of gravity, and moments of inertia.

Surface Model
A surface model is a thin shell that does not have mass or volume. AutoCAD offers two types of surfaces: procedural and NURBS. Use procedural surfaces to take advantage of associative modeling, and use NURBS surfaces to take advantage of sculpting with control vertices.

Mesh Model
A mesh model consists of vertices, edges, and faces that use polygonal representation (including triangles and quads) to define a 3D shape.

Unlike solid models, a mesh has no mass properties. However, as with 3D solids, you can create primitive mesh forms such as boxes, cones, and pyramids. You can then modify mesh models in ways that are not supported for 3D solids or surfaces. For example you can apply creases, splits, and increasing levels of smoothness. You can drag mesh subobjects (faces, edges, and vertices) to deform the object. To achieve more granular results, you can refine the mesh in specific areas before modifying it.

Use mesh models to provide the hiding, shading, and rendering capabilities of a solid model without the physical properties such as mass, moments of inertia, and so on.

Mesh Model – In English
A simple way to think of a Mesh Model is to imagine a balloon surrounded by chicken wire. You can push and pull on the chicken wire, the balloon conforms to the new shape, but its mass does not change.

Mesh Models for the purpose of this session
In this session, we will be focusing on creating mesh models for the production of molds to create physical objects.

Imagine that you want to create thousands of realistic potatoes (correct size and mass). Since machining each one is out of the question because of the quantity, you turn to molds. We'll use AutoCAD mesh models to create the “work body”, and then in turn convert it into a solid, and finally subtract it from a solid block to create the mold cavity.
Prerequisites (can my setup handle Mesh Modeling)

- **Software:** AutoCAD 2010 or later.
- **Hardware:** It depends on how fast you want to go.

Mesh modeling was introduced in AutoCAD 2010, so you must have an AutoCAD based product, release 2010 or newer. No more hanging on to r14 just because you like the way it looks.

When it comes to hardware, any computer capable of running your AutoCAD will work with mesh modeling. Unless you are working with very large, complex models, RAM is not that important. Anything over 2 gigabytes should be sufficient. The same goes for the processor. Generally, most mesh models are relatively small in nature, and do not require the latest Xeon processors to manipulate.

Where you will see the most performance difference is with your graphics card. You could use a $24.99 GeForce 210 while working with mesh models. You could also use Dixie Cups to fill a swimming pool. Your best bet is to use a workstation class graphics card, either a nVidia Quadro or ATI FirePro, selecting something from the upper end of the pack. This will allow the smooth use of more display modes within AutoCAD, such as *Realistic* and *Shaded With Edges*.

Getting Started

Template Files

Out of the box, AutoCAD comes with two basic templates, `acad.dwt` and `acad3D.dwt`. Both are very similar, in that they have the minimum set of parameters necessary to start a drawing. However, you should choose the `acad3d.dwt` template as your starting point for modeling, as the system settings are optimized for 3D work. These settings facilitate the use of the Gizmo's and the background display optimized for 3D. You can always start with the default `acad3D.dwt` and add your own layers and linetypes. Just remember to do a “saveas” so you fall back to the `acad3d.dwt` if necessary.

Workspaces

Unless you really enjoy typing all AutoCAD commands, you will need to access the 3D modeling workspace. This will give you access to all the really cool 3D features of AutoCAD, including the Mesh ribbon panel.
Display Options

By default, the `acad3d.dwt` template will start with a *Perspective* projection. This is useful if you are laying out a scene, but can be quite distracting or even misleading when spinning the model around during the editing process.

Beyond the obvious geometric differences between *Perspective* and *Parallel*, you will find that the *Parallel* projection comes with a “horizon” of sorts. You may want to turn the horizon off, as it can be a drain on the graphics system as well as being a distraction.

To turn off the horizon, you will need to change the colors of a few display elements, which can be accessed through Options ➔ Display ➔ Colors button.

Once in the “Drawing Window Colors”, change the Context to *3D Perspective Projection*, and then change the color of the top six items to black, white, or your favorite color somewhere in between.

You may also want to turn off the Grid <F7>, although it does provide a good reference to the XY plane (Z=0).
The Mesh Ribbon Tab

The Mesh Ribbon tab consists of six panels, five of which we’ll cover briefly in this session.

1. Primitives – Used for creating Meshes
2. Mesh (Refinement) – Used to refine the entire Mesh
3. Mesh Edit – Used to modify parts/faces of a Mesh
4. Convert Mesh – Many CAD and CAM systems only understand a solid object
5. Selection – Useful for selecting only what you want
6. Mesh model creation

The best way to start a mesh model for an organic, non-prismatic shape is to, believe it or not, start with a geometric primitive such as a mesh Box, Cone, or Sphere. Before creating your first mesh primitive, the number of vertexes per side (tessellation divisions) must be set.

Setting the tessellation divisions
On the Mesh Tab, Primitives Panel, click on [Click here to set the Tessellation Divisions]
Considerations for mold design
When setting the tessellation divisions, you should consider how the final model will be used. For example, how much detail you need and the type of molding process to be used. Most molding processes require a parting plane where two parts of the mold meet. We will need to consider where this parting plane will be both when setting the tessellation divisions and placing the mesh in the drawing.

Tessellation divisions
These are the number of mesh segments per face of the primitive object we choose to create. The more divisions you have, the finer the level of detail you can sculpt on your model. Initially, you may think that it would be a good idea to just bump this up to the maximum to start with. Not necessarily a good thing. The more divisions you have, the more computing power required to work with the model. More importantly, it also means that there are just that many more points you need to manipulate to get the shape you are looking for. The mesh model shown on the right was created from an 8 X 10 X 3 mesh box primitive, and you can see that it has plenty of surface bumps, ridges and depressions on it. Fewer tessellation divisions allow for a smoother, flowing surface.

Mesh placement in the drawing
After determining the size of your mesh, you need to think about where it goes in the model. When creating a mesh primitive in AutoCAD, the initial shape will be drawn on the current UCS at the current elevation. In a new drawing, this will be on the XY plane at a Z=0 elevation.

If we are creating a baked potato that is roughly 3” high, 3” wide and 6” long, we would probably want to put the middle of the potato at 0,0,0. This means that we could use the origin XY plane as a parting plane for our two mold halves, with one above and one below this plane. In order to get the center of our potato at a zero elevation, we could either create the mesh primitive first and then move it down 1.5”, or set the elevation to -1.5” before creating the mesh primitive.

Command: Elevation
Enter a new value for ELEVATION <0.0>: -1.5

Now that we know that the zero elevation will be our parting plane, we can manipulate any mesh vertices in any direction that are either above or below the XY plane, but for those that are on the XY plane (Z=0) modify only in the X and Y directions, leaving them at Z=0.
Modeling Assistance

There is still one more thing to do before creating a mesh primitive that will make the modeling process a little easier: a sketch. Let’s say that you want to model an amoeba, and that it must be 3” X 2” X 1.5” for some reason. Rather than just creating a mesh box and then morphing into a shape, why not create a sketch (using Sketchbook Designer or even just a spline), then make sure that sketch is the size you need in AutoCAD (3” x 2” for the amoeba). This way, when you create the mesh primitive box you can place it mostly inside the amoeba sketch and pull vertexes out to the sketch line (this will make more sense in a little bit).

Creating a Mesh Primitive

Now that everything is in place, it’s time to create a Mesh Primitive. AutoCAD provides seven primitives, and the finished shape of your model will determine which primitive you start with.

Only experimentation and experience will tell you which is the best starting shape for your model, but think back to the earlier analogy of the chicken wire. You want to be able to push and pull the model vertexes into the correct shape, but you also don’t want to spend three days doing it. Generally speaking, a mesh box is often the best choice.

Creating a mesh primitive is very similar to creating a solid primitive. For most objects, you create the base shape (rectangle or circle) and then select a height.

The only exception to that method is the mesh sphere and mesh torus.
**Revolved Mesh Surface**

Sometimes it’s just not practical to create a finished mesh model by starting with a mesh primitive, especially if the overall shape is round or cylindrical (think UFO or an ear of corn). The official term is “Rotational Symmetry” or “Axial Symmetry”. For these cases, we can use the Revolved Mesh Surface.

As with a revolved solid, we start with the shape to revolve and a line to revolve it about.

Unlike a revolved solid, we need to set the number of tessellation divisions to use. These are set using SURFTAB# system variables, which can be thought of as latitude and longitude line along the revolved mesh. Each line/arc segment of the revolved shape will be divided into the number of tessellation specified by the SURFTAB2 system variable.

**SURFTAB1**: Longitude - the long lines parallel to the axis of rotation  
**SURFTAB2**: Latitude - the lines horizontal on surface, perpendicular to the axis

Consider the two views of the same revolved surface below. It is a sphere created by revolving a semicircular arc around its center point. You can see the 24 divisions around the “equator”, and the 4 divisions along the axis.

**SURFTAB1**: 24  
**SURFTAB2**: 4
Displaying a Mesh Model

AutoCAD, at least in the past few releases, comes with an impressive array of visual display styles and materials already configured. While working with a mesh model, it may be beneficial to switch between some of these display modes.

<table>
<thead>
<tr>
<th>Display Style</th>
<th>Description</th>
<th>Graphics Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shades of Gray</td>
<td>Simplest non-wireframe display</td>
<td>Low</td>
</tr>
<tr>
<td></td>
<td>Graphics Requirement: Low</td>
<td></td>
</tr>
<tr>
<td>Conceptual</td>
<td>Provides different level of detail than shades of gray</td>
<td>Medium</td>
</tr>
<tr>
<td></td>
<td>Graphics Requirement: Medium</td>
<td></td>
</tr>
<tr>
<td>Shaded</td>
<td>Very high level of surface detail</td>
<td>High</td>
</tr>
<tr>
<td></td>
<td>Graphics Requirement: High</td>
<td></td>
</tr>
<tr>
<td>Shaded With Edges</td>
<td>Same detail level as shaded</td>
<td>Very High</td>
</tr>
<tr>
<td></td>
<td>Shows edge (contour) information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Graphics Requirement: Very High</td>
<td></td>
</tr>
<tr>
<td>Realistic</td>
<td>Displays materials and shadows</td>
<td>Highest</td>
</tr>
<tr>
<td></td>
<td>May not be able to see some details</td>
<td></td>
</tr>
</tbody>
</table>
Changing/Adjusting Visual Styles

AutoCAD 2012 introduced the In-Viewport display controls, allowing you to quickly change the visual style used in a viewport.

To change between visual styles, simply click on the visual style name in the upper left corner of a viewport.

This will cause the list of available style to fly out, where you can select the visual style to be applied to the current viewport.

Prior to AutoCAD 2012, the simplest way to change the display style for a viewport was to navigate to the View tab on the ribbon and select the visual style from the drop-down list on the Visual Styles panel.

By default, the Shaded with Edges visual style shows the edges of a model as “By Entity”, meaning that they will be a lighter shade of whatever color the mesh is. That also means that they don’t stand out very well.

It may be beneficial for you to change the color of the edges. To do this, make use of the “Visual Styles Manager”.

Scroll down to the “Edge Settings” section.

You definitely want to show “Isolines”, not “Edges”

Change the color to something that stands out against the overall color of the mesh model.

These visual style settings stay with the drawing.
Modifying a Mesh Model

After a mesh, either primitive or revolved, has been created, it is still very geometric in nature. Anybody can create a geometric shape with AutoCAD. That’s why one of the focus points of this session is on creating non-prismatic shapes. In other words, we’re going to now learn how to turn a cube of granite into a well-worn river rock.

We do this by pushing and pulling on our mesh. Remember the balloon surrounded by chicken wire?

Subobject Selection
In order to push and pull, you first select part of the mesh to move. If you just click on a mesh model, the entire object will be selected. You need instead to select a subobject of the mesh, either a face, edge or a vertex.

To select a face, edge, or vertex, press and hold Control as you select the object.

As you continue to hold down Ctrl, you can select as many subobjects as needed. It’s just like selecting regular AutoCAD objects such as lines, arcs and text.

To de-select a subobject, hold down Shift as well as the Ctrl and select the subobject.

Simplifying Subobject Selection
Since you probably don’t want to hold the Ctrl key down all day, AutoCAD provides a few ways to simplify the subobject selection process: Culling and Filters.

Culling
It can be difficult to select just the topmost subobject of a mesh. Turning on Culling forces AutoCAD to select just those subobjects on the visible surface of the mesh.

The visual style of the viewport must be set to one of the shaded styles (not wireframe).

Filters
Rather than holding down the Ctrl key all day, you can use filters.

When a subobject selection filter is on, you do not need to press and hold Ctrl to select the face, edge, or vertex of a 3D model. However, you need to turn off the filter to select the entire object.

When a subobject filter is turned on, a small icon is displayed near the cursor.
Selecting Multiple SubObjects

There is an obscure system variable that controls the behavior of the grips when you select multiple subobjects, such as faces or edges.

The GRIPSUBOBJECTMODE system variable controls whether grips are automatically selected (made “hot”) when subobjects are selected.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not turn grips hot when subobjects are selected.</td>
</tr>
<tr>
<td>1</td>
<td>Turns the face, edge, or vertex grips hot when subobjects of 3D objects (solid, surface, or mesh) are selected.</td>
</tr>
<tr>
<td>2</td>
<td>Turns the grips hot when subobjects of 2D polyline objects (line or arc segments) are selected.</td>
</tr>
<tr>
<td>3</td>
<td>Turns the grips hot when subobjects of 3D objects (faces, edges, or vertices) are selected and 2D polyline objects (line or arc segments) are selected.</td>
</tr>
</tbody>
</table>

By default, this variable is set to “1” in the AutoCAD acad3d.dwt template. However, in the default AutoCAD acad.dwt template, as well as the Civil 3D templates, the default value appears to be set to “0”. This behavior can be quite frustrating when trying to manipulate multiple subobjects at the same time by selecting multiple subobjects with a window, crossing or fence method.

Only the first subobject (as determined by AutoCAD) will have its grip made hot if the value is set to “0”.

If the value of GRIPSUBOBJECTMODE is set to 1 (or higher), all of the grips of the selected subobjects will be made hot when using a multiple selection method.
The Gizmos

After selecting a subobject, a Gizmo should appear, allowing you to modify the subobject, enabling transformations like move, rotate or scale. If the Gizmo does not appear, it's probably because you have the viewport visual display style set to 2D Wireframe. It must be any of the other visual styles.

To switch between the Gizmos, simply select one from the drop-down list in the subobject panel of the Mesh Modeling ribbon tab.

The Move and Scale Gizmos allow translation or scaling along the X, Y, or Z axis, or on the XY, XZ, or YZ plane. The Rotate Gizmo allows rotation along the X, Y, or Z axis.

After selecting one or more subobjects, grab the grip of a single subobject, or any of the grips if multiple subobjects are selected. The subobject(s) will now be moved.

To move the subobjects in a specific direction along an axis or plane, utilize the Move Gizmo. Simply click and hold on the axis or plane you want to move along, then drag the mouse. The subobject will move only along the axis or plane selected.

The Rotate Gizmo allows for rotation about the X, Y, or Z axes, and is most useful for Face or Line subobjects. A single line or face will be rotated about the selected axis running through it's midpoint, and multiple subobjects will be rotated about the selected axis of the subobject chosen. To change the selected subobject, and thus the rotation point, simply hover over the grip of a different subobject and the Gizmo will jump to that grip.
Smoothness
Mesh objects are made up of multiple subdivisions, or tessellations, which define the editable faces. Each face consists of underlying facets. When you increase smoothness, you increase the number of facets to provide a smoother, more rounded look.

As you work, you can increase or decrease the level of smoothness. The differences are apparent both in the wireframe and conceptual visual styles as well as in the rendered output. A higher level of smoothness will require more system resources to draw on the screen, so it is often a good idea to model mesh objects at lower smoothness levels and increase the smoothness only as the model nears completion.

Creases
You can sharpen, or crease, the edges of mesh objects. Creasing deforms mesh faces and edges that are adjacent to the selected subobject. Creases added to a mesh that has no smoothness are not apparent until the mesh is smoothed.

You can also apply creases to mesh subobjects by changing the crease type and crease level in the Properties palette.

The Tedious Part
Now that you have the basic tools necessary to create and modify a mesh model, it’s time to make the mesh primitive into what you need.

Using the subobject selection filters and the Gizmos, push and pull on vertexes, lines and faces to shape the mesh primitive into something resembling your final product. Use the smoothness level to turn the geometric shape into something a little less prismatic.

This is a lot like working with a finite lump of clay. You can’t just add more stuff on to your model, but you can stretch bits and pieces of it around until it looks good.

Be careful not to tear a hole in your mesh by moving it back on top of itself. In order to get this model into a production environment, the mesh model needs to be watertight so that it can be converted into a solid and then exported for mold making.
A Mesh With Mass
Autodesk Mudbox® is like a digital lump of clay. Organic shapes are easy to create, and the level of detail available is incredible. But it has no mass or volume properties, and won’t export that level of detail into something usable outside of Mudbox or 3ds Max®. Autodesk Inventor has the necessary mass and volume capabilities, but it doesn’t do organic shapes. AutoCAD has the ability to create an organic shape of a specific size and shape, but the mesh object itself has no mass. So, if a model needs to be made of a certain material and/or have a specific weight, what can we do to make it the right size?

Determining Volume
If you look in the Properties window or LIST a mesh model, it does not show a mass or volume. Use the MEASUREGEOM command with the VOLUME option, and select an OBJECT.

Command: MEASUREGEOM
Enter an option [Distance/RADIUS/Angle/ARea/VOLUME] <Distance>: VOLUME
Specify first corner point or [Object/Add volume/Subtract volume/eXit] <Object>: OBJECT
Select objects:
Volume = 182.3674

That sequence of keystrokes can get quite repetitive, so consider creating a new command called GetVolume and placing it on the Quick Access Toolbar.

Access the CUI
Create a new command
Name it something (GetVolume)
Type in the command macro
=C_MEASUREGEOM V O \; ^
Expand the Quick Access Toolbar
Drag the new command to the Q.A.T.

Now all you have to do is click the button and select the mesh.
Calculating Weight and Volume

Since we can use the MEASUREGEOM, or the newly created GetVolume, command to get the volume of the mesh, we can calculate what the weight of the real, physical object will be simply by multiplying the volume of the object by the density of the material to be used.

\[
\text{Volume} \times \text{Density} = \text{Weight}
\]

Example:

<table>
<thead>
<tr>
<th>Model Volume:</th>
<th>4.18 in³</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density of Glass:</td>
<td>1.45 oz/in³</td>
</tr>
<tr>
<td>Calculation:</td>
<td>4.18 * 1.45 = 6.06</td>
</tr>
<tr>
<td>Weight of Paperweight:</td>
<td>6.06 oz</td>
</tr>
</tbody>
</table>

We can also work this the other way.

Suppose we know the weight of the final product, such as an 8 ounce chicken breast. Since the density is known, the desired volume can be calculated.

\[
\frac{\text{Weight}}{\text{Density}} = \text{Volume}
\]

| Weight of lunch: | 8.00 oz |
| Density of Chicken: | 0.44 oz/in³ |
| Calculation: | 8.00 / .44 = 12.50 |
| Desired Model Volume: | 12.5 in³ |

Sculpting with Precision

Now that the necessary volume for the mesh model is known, it can be sculpted to get not only the correct shape, but the correct volume as well.

As the mesh model nears completion, the smoothness level should be increased. This will give it a more organic look and feel. Before measuring for the final volume, make sure that the smoothness level is set to the desired level, because the volume will change with the smoothness level as the sharp edges are rounded off.

Getting the correct volume is an iterative process.

1. Create the rough model
2. Set the smoothness level
3. Measure the volume
4. Adjust the model (pull a face out if too low, push it in if too high.)
5. Repeat steps 3 and 4 as necessary
Converting a Mesh to a Solid

The mesh model is complete: correct size, shape and volume. One more step remains before it can be used in a manufacturing process: converting it to a solid.

Most CNC/CAM software will not know what to do with a mesh. Autodesk Inventor doesn’t like a mesh object either, so it should be converted to a solid before export.

Even if a mold cavity is to be created in AutoCAD, the mesh needs to be converted to a solid so that a Boolean subtraction can be performed between the mold block and the work body.

When performing any sort of conversions or Boolean operations on solid or mesh models, the original object(s) is deleted. This means that when you convert the mesh to a solid, the mesh no longer exists. This is bad. Especially if you need to adjust the mesh, since it’s gone.

The DELOBJ system variable controls this. With a default value of 3, all defining geometry is deleted. Setting DELOBJ = 0 will retain all defining geometry.

- Smooth, optimized
  Creates a smooth model that merges faces.

- Smooth, not optimized
  Creates a smooth model with the same number of faces as the original mesh object.

- Faceted, optimized
  Creates an angular model that merges planar faces.

- Faceted, not optimized
  Creates an angular model with the same number of faces as the original mesh object.

In order for the solid to be as close in appearance and volume to the original mesh object, the conversion method should be set to “Smooth, optimized”.

To convert the mesh to a solid, click on the Convert to Solid button found on the Convert Mesh panel of the Mesh Ribbon tab.
Analysis
AutoCAD provides analysis tools for solids and surfaces, but not meshes, so the analysis tools are not available until after the mesh model has been converted into a solid.

Use the surface analysis tools available in the Analysis panel of the Surface Ribbon tab to validate surfaces and curves before manufacturing.

**Zebra Analysis** - Analyzes surface continuity by projecting parallel lines onto the model.

**Curvature Analysis** - Evaluates areas of high and low surface curvature by displaying a color gradient.

**Draft Analysis** - Evaluates whether a model has adequate draft between a part and its mold.

Since draft angle is critical for most molding processes, the Draft analysis tool should be used before exporting a model for production. Simply click on Draft from the Analysis panel, and then when prompted, select the AutoCAD solid objects to analyze.

On a model properly constructed for molding, the analysis should show dark blue on the bottom and green on the top. This indicates that the majority of the model has a draft angle sufficient for it to be pulled from a mold.

Take some time to orbit around the model along the parting plane. Any areas that show up as a color other than dark blue or green indicate an area where the draft angle could be a problem, depending on the molding process and the medium being used.
Export the Solid

Before exporting the solid object, verify that it has the correct volume. There will be some difference in volume between the mesh model and the solid model. This difference is usually not apparent until the 3rd or 4th decimal place, but it can make a big difference on a large production run.

In the example on the previous page, the difference between the mesh and solid volumes is only 0.0208 cubic inches, but in a production run of a million units of the aluminum widget, this would result in a difference of over a ton of material.

<table>
<thead>
<tr>
<th>Volume (cu. in.)</th>
<th>Weight (oz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh</td>
<td>132.8182</td>
</tr>
<tr>
<td>Solid</td>
<td>132.7974</td>
</tr>
<tr>
<td>Difference</td>
<td>0.0208</td>
</tr>
</tbody>
</table>

Table: Volume and Weight Comparisons

| One million unit production | 32,448 oz. |
| Difference in Pounds        | 2028        |

To export the solid model, start the EXPORT command, or navigate through the Application Window to Export → Other Formats.

This will bring up a dialog box asking you for a file type as well as a file name and location.

The type of file to export really depends on what software or system you will be importing it into, but the following types are best for 3D models.

- Lithography (*.STL)
- ACIS (*.SAT)
- IGES (*.IGES, *.IGS)

After selecting a file type and name, click SAVE.

AutoCAD will then prompt for the objects to be exported. Select the object(s) to be exported.

That’s it. You have now created a mesh model, converted it to a solid, and exported it for use, either as something to be machined, or for use as a work body for creating a mold.
But wait, there’s more!

**Creating a mold cavity**

Q: How do I use AutoCAD to turn the work body into a mold cavity?

A: Subtract the work body (the mesh model converted to a solid) from another solid block.

For the sake of expediency, the work body will be subtracted from simple rectangular blocks, although a complex part design could be used.

If the work body was well thought out in the beginning, the parting plane should be on the XY plane (Z=0), although any of the three origin planes will work. To create the solid to be used for the mold, navigate to the Solid tab of the Ribbon. From this tab, use either the Box command on the Primitive panel to draw a rectangular solid, or the Extrude command from the Solid panel to extrude a closed polyline.

Create the block or polyline on the XY plane (Z=0), or on the plane used as the parting line. For the height of the extrusion, select an appropriate positive value for the top half, then repeat with a negative height value for the bottom half.

It will be beneficial to create separate layers for the work body, top and bottom parts of the mold so that individual parts can be turned on or off for visibility.

At this point, you should have two solid blocks intersecting with the work body.

Set DELOBJ =0 so that the solid work body does not get deleted when it is subtracted from the block.

Start the SUBTRACT command found on the Boolean panel of the Solid modeling Ribbon tab. When prompted for the solids to subtract from, select the mold block, then select the work body when prompted for solids to subtract.

This subtraction will result in one half of the mold. Repeat for the other half, then export.
**Life After AutoCAD**

Once you have either the work body (as a solid) or the mold cavity exported, it can be imported into many other software packages, either for use in a machine design or directly for machining.

For example, the mold cavities (and even the work body) could be imported into Autodesk Inventor and placed as a part into an assembly.

While AutoCAD can create the organic shape that Inventor cannot, Inventor is much better at creating the enhancements necessary to make the AutoCAD generated mold into a functional manufacturing part, such as overflow channels, injection ports, extraction pins and alignment holes.
Mesh Modeling in Civil 3D

Civil 3D is a model-based Civil Engineering program with very powerful tools for surface creation. In fact, a Civil 3D surface, whether it is based on a TIN (Triangulated Irregular Network) or a Grid, looks very similar to an AutoCAD surface or mesh model, with one exception: it's darn near impossible to manipulate manually.

Surface creation in Civil 3D can be accomplished through a Corridor or by Grading Objects, which work great for roads, ponds, parking lots and building pads. But if you are trying to create landscape features such as a raised berm for plantings or hazards for a golf course, Civil 3D Grading Objects leave something to be desired. This is because they rely on set criteria such as elevations and grade/slope.

One option to consider is to create an AutoCAD mesh model of the desired feature, and then add that data to the Civil 3D surface.

Although the process required to create the mesh model based surface is more involved, the end result is much more aesthetically pleasing. If the Civil 3D surface is to be used for any sort of presentation purpose, this extra work is well worth the effort.
While it is possible to manipulate gradings through feature line elevations, this is a process involving manually entering an elevation (through the keyboard) for all vertices along said feature line. This is a very time consuming process, and does not provide immediate visual feedback while you are trying to manipulate the surface.

**Yet another way to create a mesh**

Earlier we saw how to create an organic mesh shape from a mesh primitive, which involved pushing and pulling on a square block. Yet another method, which may prove beneficial for larger areas such as those you may be dealing with in Civil 3D, is to EXTRUDE a basic 2D shape into simple 3D solid, and then SMOOTH the extrusion. The process of smoothing the solid will convert it into a mesh.

Start this process by creating the outline of the shape using a 2D polyline or even a spline.

Next, extrude the 2D entity. Extrusion height does not need to be exact, only close, as you will be sculpting the resulting mesh later. However, for those wishing to use the resulting mesh as a landscape feature in Civil 3D, extrusion height does require some thought.

Civil 3D users will need to find the elevation of the high and low points of the existing ground surface within the area defined by the feature outline. When determining the extrusion height, first find the elevation difference between the high and low points, and then multiply this by 5. Once again, this is not an exact science, so integer mathematics is allowed at this time.

For example, if the elevation of the highest point within the feature is 743.23, and the lowest is 737.82, round these numbers off to the nearest integer and subtract (743 – 738 = 5). Multiply this by 5 to get a rough extrusion height (5 * 5 = 25).

This multiplier may sound a bit extreme, but you want to essentially create an iceberg. The extrusion should have most of its volume below the existing ground surface. The reason for this will be revealed during the process of converting the 3D solid into a mesh (it has something to do with tesselation spacing).

After extruding the 2D entity, you can use the move Gizmo on the solid to place it at the approximate correct elevation.
Convert the 3D solid to a mesh
Before starting this step, you may find it helpful to set the visual style to “Shaded with Edges”.

After the feature has been extruded and positioned, it’s time to convert it to a mesh.

Ignore the panel labeled “Convert Mesh”, as it converts from a mesh to something else. In fact, you won’t find a button on the ribbon labeled “Convert TO mesh” at all. Instead, you want to smooth the object. If you have much experience with 3D modeling in AutoCAD, you may know that 3D solids can’t be smoothed, nor can surfaces. In fact, the only object type that can be smoothed is a 3D mesh. Luckily, if you select a 3D solid to be smoothed, AutoCAD will kindly convert the solid into a mesh before converting.

There is a large button in the Mesh panel labeled “Smooth Object”. Ignore this as well.

Instead, click on the little arrow in the bottom right corner of the Mesh panel.

This will bring up the “Mesh Tessellation Options dialog box.

If you did not already have the 3D solid selected before launching this dialog box, go ahead and click on the select button at the top to select the extruded 3D solid.

There are three critical areas in this dialog box.

Mesh Type: Smooth Mesh Optimized.

Leave this one alone. The other options require too much thinking for now.

Maximum edge length: 25

Start with the default and see what happens. You will probably make this value smaller.

Smoothness level: 2

This determines how smooth the resulting mesh will be. Three is the smoothest, but requires the most computational power. It can be, and should be, changed later.

After changing and/or verifying all the settings, click on Preview in the lower left corner.
The maximum edge length determines the number of tessellations (divisions) created on the new 3D mesh. You want to create enough tessellations so that the mesh can be molded the way you want, but not so many that it takes forever to do so.

In this example, the feature was extruded 25 feet. When the maximum edge length is set to 25, no tessellations were created in the vertical direction.

Additionally, very few tessellations were created on the top of the feature. In fact, most of the tessellation lines go all the way across the top of the feature.

These settings will make it very difficult to set slopes near the ground and impossible to give the top a natural looking curve.

A maximum edge length of 5 delivers numerous tessellations on the top of the mesh, allowing for fine sculpting, but that same abundance means that it will take longer to perform said sculpting.

There are also many tessellations in the vertical direction. Ideally, you want one or two tessellation lines above the existing ground surface. A shorter extrusion would have resulted in fewer vertical tessellations.

In this case, a maximum edge length of 10 provides sufficient tessellations on the top of the mesh, and the first vertical tessellation line is right at the existing ground level.

For this feature, a maximum edge length of 10 appears to be the magic number to use.
After determining the appropriate settings in the Mesh Tessellation Options dialog box, clicking on OK will start the smoothing process. AutoCAD will recognize that the 3D solid is not a primitive solid (i.e., not a box or cylinder) and will ask you what to do next. You want to click on “create mesh”.

Congratulations, you now have a shiny new mesh object you can shape! Go back to page 11 in case you forgot which tools to use for the sculpting.

Making sculpting easier (at least in Civil 3D)

Since landscape features are usually relatively small in comparison to the entire Civil 3D surface, you might want to create a temporary outer boundary on the existing surface(s), offset 20’ or so around around the feature you are creating with a 3D mesh. It is also a good idea to create a surface style entitled “No Display” (with all display items turned off), and apply this to all surfaces not involved in the feature creation. This will not only speed up computations, but it will make it much easier to orbit around the model to see both the area above and immediately below the existing surface. The temporary outer boundary can be disabled or deleted after you have finished the mesh modeling and created a Civil 3D surface from it. However, this boundary option does not work on data referenced surfaces.
Creating a Civil 3D surface from a mesh object

One of the definition sources for a Civil 3D surface is **Drawing Objects**, but there are "gotchas".

**Bad:** 3D Mesh is not one of the acceptable types of drawing objects.

**Good:** Explode a mesh and it becomes 3D faces, with are acceptable drawing objects.

**Bad:** Adding all the faces from an exploded mesh creates TIN lines between all the faces, including lines between the top and bottom.

**Good:** You can delete all the 3D faces below the surface (above the surface if you are creating a sand trap on a golf course).

**Bad:** TIN lines will still be created between the existing TIN vertices and the vertices of the 3D faces added to the surface. This may leave a ditch/ridge around the newly added feature or create undesirable transitions between the existing surface and the newly added feature.

Depending on the desired result, this may be acceptable. It all depends on the density of the existing surface TIN and the accuracy of the mesh you create.

Using a mesh to augment a surface (the quick method)

To summarize the quick method:

1. Create the outline of the new feature
2. Extrude the outline
3. Smooth the 3D solid extrusion into a mesh
4. Sculpt the mesh as desired
5. Explode the mesh
6. Delete the 3D faces below (or above) the existing surface
7. Add the 3D faces to the surface definition

If the method just described does not produce a suitable surface, there is a way to make a much more accurate method for producing the rendition of the newly created proposed grade.

The "accurate" method is purposely placed on the next page because it looks really scary.

It’s not, though. The list of steps is quite long, but it’s not as bad as it first seems.
Using a mesh to augment a surface (the accurate method)

1. Create a 3D mesh of the proposed feature
   a. Create the outline of the new feature
   b. Extrude the outline
   c. Smooth the 3D solid extrusion into a mesh
   d. Sculpt the mesh as desired
2. Prepare existing ground surface
   a. Copy the existing ground surface
   b. Move the copy out of the way set distance
   c. Explode surface twice into 3D faces (surface → block, block → 3D faces)
   d. Convert 3D faces to surface
   e. Union converted surfaces
   f. Extrude solid from unioned surface
   g. Union the solids if necessary
3. Trim the proposed feature to the existing ground
   a. Convert feature mesh to solid
   b. Subtract existing surface solid from proposed feature solid
   c. Convert remaining feature solid to a surface
   d. Explode that surface
   e. Erase “flat” bottom (or top), leaving just a shell of the proposed feature
4. Prepare new feature for adding to finished grade surface
   a. Union remaining surfaces
   b. Smooth (converting back to mesh)
   c. Explode mesh to 3D faces
   d. Move faces back to original location
5. Add the new feature to the finished grade surface
   a. Create new surface for feature
   b. Add 3D faces to new surface
   c. Remove extra TIN lines if necessary
   d. Paste new surface into finished grade surface
6. Clean up if necessary
   a. Delete TIN lines if necessary
   b. Swap faces if necessary

That sounds horrible, doesn’t it? 25 steps just to create a mound of dirt?

It’s not nearly as bad as it sounds. After you’ve done it two or three times, it’s actually a pretty quick process. More details follow on the next pages…
1. Create a 3D mesh of the proposed feature
   a. Create the outline of the new feature
   b. Extrude the outline
   c. Smooth the 3D solid extrusion into a mesh
   d. Sculpt the mesh as desired

   This step has already been explained several different ways, but you can refer back to page 24.

2. Prepare existing ground surface
   a. Copy the existing ground surface

      Copying the existing ground surface is not really optional, as you will be destroying it soon. If you are using data referenced surfaces, you will need to promote the copy at this point.

      It is also strongly recommended that you create a surface outer boundary on the copy a ways outside the proposed feature, large enough to completely cover the entire mesh, even the hidden parts of the “iceberg” (described several pages ago).

   b. Move the copy out of the way set distance

      This step is optional, but it does allow you to work in a clean area of the drawing. If you do not wish to move the surface out of the way, set the original surface style to No Display.

      You could also WBlock the copied surface and proposed landscape feature out to their own drawing and work on them in a totally clean environment without having to worry about messing up your production drawing.

   c. Explode surface twice into 3D faces (surface \( \rightarrow \) block, block \( \rightarrow \) 3D faces)

      Exploding the surface twice converts it from a Civil 3D surface into AutoCAD 3D faces.

   d. Convert 3D faces to surface

      Working with the 3D faces individually is quite difficult and time consuming. The objective is to just deal with a single AutoCAD surface. Converting multiple faces to surfaces allow you to use the union command to merge many small surfaces (the triangles from the original TIN) into single, larger surface.

      To convert the 3D faces to a surface, use the Convert to Surface command located on the Convert Mesh panel of the Mesh tab. Make sure that the conversion option is set to “Faceted, not optimized”.
e. **Union converted surfaces**

Use the *Union* command found on the *Solid* tab, selecting all the small surfaces just converted from 3D faces. The original 3D faces will probably still be there, so you might want to select just one, then *Select Similar* and delete them all at once. You don’t need the 3D faces any more, as you now have one AutoCAD surface to work with.

f. **Extrude solid from unioned surface**

*Extrude* a solid from the new AutoCAD surface. Make sure you use the Extrude command on the *Solid* tab, NOT the one on the *Surface* tab. You want to create a solid, so that you can subtract one solid from another.

The extrusion distance should be far enough to completely encase the unwanted part of your landscape feature.

g. **Union the solids if necessary**

Even though you just extruded a single AutoCAD surface, it may result in multiple extruded solids. If this is the case, *Union* them back together into one solid.

3. **Trim the proposed feature to the existing ground**

a. **Convert feature mesh to solid**

Use the *Convert to Solid* command located on the *Convert Mesh* panel of the *Mesh* tab to convert the sculped landscape feature mesh into a solid. Make sure that the conversion option is set to “Faceted, not optimized”.

b. **Subtract existing surface solid from proposed feature solid**

Now that you have two solids, you can subtract the extruded existing ground solid *from* the just converted landscape feature. This will leave you with just part of the original mesh that is right at the existing ground elevation. This way, when you add the proposed feature to the Civil 3D surface, no TIN lines will be created that extend above or below the original surface.
c. **Convert remaining feature solid to a surface**

You have already done this step with the existing, exploded Civil 3D surface, now it's time to do the same thing with the proposed surface modifications.

d. **Explode that surface**

Before you can add the proposed feature to a Civil 3D surface, you will need to erase the bottom of it. Converting a solid to a surface just creates a “watertight” AutoCAD surface, so it needs to be exploded into smaller surfaces that are *not* connected to each other.

e. **Erase “flat” bottom (or top), leaving just a shell of the proposed feature**

Orbit around the model of the proposed feature so that you can see the bottom side. It will consist of several smaller planar *regions* that correspond to the TIN lines from the original Civil 3D surface you subtracted from it. These will need to be erased so that they do not become part of the proposed surface.

Since the bottom of the proposed feature consisted of flat (planar) areas, they become “regions” when the converted solid (now surface) is exploded. The smoothed portions of the exploded surface remain as surfaces.

You can select these regions one at a time, but **Select Similar** works great at this point.

Erasing the un-needed portion will leave just an open shell of the proposed feature.
4. Prepare new feature for adding to finished grade surface
   
a. Union remaining surfaces

   The remaining patchwork of small surfaces needs to be unioned back into just one surface, otherwise the edges of the multiple surfaces will be rounded in the next step, leaving holes in the proposed surface.

   
b. Smooth (converting back to mesh)

   Now **Smooth** the AutoCAD surface object. You can even use the big button on the Mesh panel this time. Click **Create Mesh** when the warning dialog box pops up.

   The only reason to convert from AutoCAD surface to AutoCAD mesh is so that it can be exploded yet again, which will create 3D faces.

   
c. Explode the mesh to 3D faces

   
d. Move faces back to original location

   *If you moved the working set of object out to the side earlier so that you could work on them in an unspoiled area of the drawing, it’s now time to move them back into their proper location.*

   *Or, if you WBlocked them out to their own drawing, it’s time to insert it back into your production drawing.*

   *Whatever the case, they need to be in the proper location before proceeding.*

5. Add the new feature to the finished grade surface

   After all that work, it’s now time to use some actual Civil 3D functionality!

   
a. Create new surface for feature

   Creating a new Civil 3D surface for the proposed feature allows a lot more control of the resulting surface, and makes editing the TIN much easier. If you are creating multiple landscape features using this mesh modeling method, create a new surface for each feature.

   You might want to set the style of all other surfaces to “No Display” at this point.
b. Add 3D faces to new surface
   i. In the Prospector, expand out the new surface
   ii. Expand out the Definition
   iii. Right-click on Drawing Object
   iv. Click Add
   v. Set the object type to 3D Faces
      ![Add Points From Drawing Objects](image)
   vi. Click OK
   vii. Select all the 3D faces that make up the new proposed feature

After this step, you might want to make sure that the 3D faces that were added to the surface are on their own layer, and then Freeze that layer. You can't delete the faces, and you don't want them slowing down your drawing.

c. Remove extra TIN lines if necessary

When the 3D faces are added to the surface, Civil 3D will try to connect all the outside points along the surface exterior. If you proposed Civil 3D surface has any interior curves to it, there will be extra TIN lines that need to be removed.

Change the surface style to one that displays Triangles, and set the visual display style to 2D Wireframe. This will allow you to edit the TIN.

Some of these TIN lines will be easy to see, and therefore delete. You could right-click on Edits in the surface definition, select Delete Line, and then delete all the extraneous TIN lines along the interior curves. This is somewhat tedious, and requires zooming in close.
A more practical method, however, is to set a maximum triangle distance. Since the 3D faces added to the surface are rather small, setting a small maximum triangle length will eliminate most if not all of the unwanted TIN lines. Zoom in on the surface until you can see the individual triangles that make up the surface and measure the length between points. It’s probably less than a foot.

Go into the Surface Properties → Definition → Build and turn on “Use maximum triangle length”. Set the maximum length to 1.00’. Click on OK, which will trigger a rebuild of the surface.

After the rebuild, set the visual style to something that shows the surface, such as realistic, conceptual, or shaded (with edges).

Orbit around the new surface looking for holes. If you find any, raise the maximum triangle length up just a bit, say 0.005’. Rebuild and look for holes. Repeat until no more holes appear in the new surface.

d. Paste new surface into finished grade surface

If you haven’t already done so, create a new surface for the Finished Grade.

Set the style for all the surface (except the Finished Grade surface) to “No Display”.

Now, paste the Existing Ground surface into Finished Grade. This will give you something to build on.

To paste one surface into another:

1. Expand the surface
2. Expand Definition
3. Right-Click on Edits
4. Click on Paste Surface…
5. Select the surface to paste

Next, paste the proposed landscape feature surfaces into the Finished Grade surface as well.
If you cleaned up your proposed surfaces well in the previous steps, you are finished.

6. **Clean up if necessary**

   e. Delete TIN lines if necessary
   f. Swap faces if necessary

Whew, that was a lot of steps.

Don’t Panic!

The worst part is the sculpting of the mesh, and even that becomes pretty quick with practice.

After the mesh is sculpted, most of the remaining steps in the process consist of just one or two button clicks. In fact, your speaker was able to add the mesh to a finished grade surface in under 4 minutes (after sculpting, of course).

**As you can see from the images below, the resulting surface created from a mesh model looks much better than that created from grading objects.**
The Beginning

The process of using AutoCAD to produce an non-prismatic shape with a desired mass using mesh modeling is NOT an exact science, but rather an iterative process. The same holds true for those wishing to use mesh models to create landscape features on a Civil 3D surface.

The first one you try will most likely drive you batty. Do not give up. Practice and experience will make the process easier. It helps to have a physical sample to refer to, not necessarily for precise measurements, but more for the overall shape and feel of the object.

Good luck!
Organic Mesh Modeling for Manufacturing (Outline)

1. Start with an idea, model, or sketch
2. Create a new drawing, starting with acad3d.dwt
3. Create or import a sketch or boundary on the parting plane (XY plane recommended)
4. Determine and set the number of tessellation division necessary for your model
5. Create a Mesh Primitive (mostly) inside the boundary
   a. Set the elevation before creating so that the parting plane is at Z=0
6. With the smoothness set to 0, make gross adjustment to the mesh
   a. Keep all vertexes on the parting plane at Z=0 to maintain draft angles
   b. Push and pull faces, lines and vertexes (in that order) into position
7. Smooth the mesh one level
   a. Adjust as necessary to get the desired shape
8. Repeat Step 7 until you reach the maximum level of smoothness, and the desired shape
9. If a specific volume or mass is required, use MEASUREGEOM to obtain the volume
   a. Adjust as necessary
10. Convert the Mesh to a Solid
11. Use Analysis tools
12. Create a mold cavity if necessary
13. Export
Notes, ideas, advice, and other random thoughts...

- Your first time (at organic mesh modeling) can be painful. Keep it simple.
- Use a sketch, even if it’s a scan of something drawn on the back of a napkin.
- Model complexity kills performance. Don’t smooth the mesh until it’s necessary.
- Display complexity kills performance. Shades with Edges has the worst performance, but it is the best for working with as you get near the final shape. Catch 22.
- Use multiple viewports in model space to get a clear picture of what’s going on.
- If the model is to be used for molding, remember draft angles. You must be able to extract it from the mold.
- Occasionally, bump the smoothness level up to the max, just to see how it may change the overall shape of your mesh. You can always back it down and keep working.
- Although it’s possible, try to avoid splitting faces of the mesh. It just creates more problems than it solves.
- Measure the volume of the mesh often if a specific mass or volume is required:
  - Crank the smoothness level all the way up.
  - First time should be just after making the gross adjustments to the shape. This will let you know you are anywhere near the ballpark for the volume. It will also tell you if you need to push in or pull out on the model faces.
- When moving subobject around, do not overlap. This will tear the mesh.
- Use multiple layers for various object and part types.
- Set DELOBJ=0 before converting a mesh to a solid. This way you will retain the original mesh in case additional refinements are needed (and they will be).
- Measure the volume of the solid after converting:
  - A few decimal places will be lost or gained.
  - Make sure it is the solid that is measured. With DELOBJ=0, the mesh and the solid will be on top of each other. Put them on different layers.
- Use surface analysis after converting to a solid. Remember the draft angles.
- Use creases to create sharp ridges or valleys on the mesh.
- AutoCAD is great at creating the organic shape, but Inventor is better at making parts.
- After finalizing the Mesh model, SAVEAS before converting to a Solid. Just in case.
  - You cannot convert a solid back into the original mesh it was created from
- Use the .x, .y, and .z point filters if necessary.
- Always keep the draft angles in mind.